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GENERALIDADES




Manual de Usuario Del Boceto a la Impresion Final

1.1 INTRODUCCION

Es muy comun que al iniciar la produccion de un material impreso, (revista,
folleto) se ponga énfasis en el diseno, los objetivos, etc., pero al momento de
ejecutarlo, se encuentre con dificultades a las que tendra que responder.

Después de haber superado esta primera parte, nos vemos avocado a elegir
el tipo de material en que se imprimira, el tipo de impresién que elegira,
el acabado que tendra el producto,etc. Frente a esto se tiene que conocer
como es el proceso después del disefio digital, esto es la PREPRENSA,
PRENSA y ACABADO FINAL.

Existen consideraciones técnicas, que se debe tomar en cuenta al diagramar
(elaborar los artes finales) como tipo de colores, tamano y formato de
imagenes, excedentes; para evitar que otros ‘arreglen’ los ‘errores’ o
nuestras omisiones técnicas.

Este manual, recoge sistematicamente, los pasos de este proceso al que
se h llamado “DEL BOCETO A LA IMPRESION FINAL". y que tomo como
referencia, una de las revistas que produje para Ecuajey Records.

EDCOM Capitulo 1 - Pagina 1 ESPOL



Manual de Usuario Del Boceto a la Impresion Final

1.2 OBJETIVO GENERAL

Dotar de una herramienta de consulta, para la realizacion, impresion vy
control de calidad de materiales impresos, como revistas, folletos y otros
similares.

1.3 OBJETIVOS PARTICULARES

Que el usuario planifique, organice, procese y diagrame un producto
impreso.

Que el usuario se dote de técnicas para el procesamieno de imagenes
destinadas a la prensa

Que el usuario conozca y use las técnicas y parametros de la diagramacion
de artes finales.

Que el usuario conozca el proceso completo, para el mejor control de
calidad del producto.

EDCOM Capitulo 1 - Pdgina 2 ESPOL
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1.4 DIRIGIDO A:

Estudiantes, tecndlogos y disefnadores, que estan dedicados a la
diagramacion, control de calidad y disefio de material impreso, como libros,

revistas, folletos.

EDCOM Capitulo I - Pdagina 3 ESPOL
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2.1 OFFSET

Para empesar, se debe conocer la técnica con la que se imprimira el material,
y de alli tomar las consideraciones necesarias.

En el mercado existen varias técnicas de impresion, pero cuando se trata
de imprimir una revista en “full color”, se esta hablando del OFFSET. Pero
iqué es o0 en qué consiste esta impresion?. Se la abordara a continuacion.

Esto no es la historia del offset, ni recoge elementos totales, pero si explica
los elementos fundamentales.

El principio basico de este sistema esta basado en la repulsion entre el agua
y la grasa. Las tintas utilizadas estan formadas por agua y grasa. La forma
de impresion es indirecta, es decir, que no se realiza directamente sobre el
papel, sino que mediante presion es transferida a una mantilla de caucho
(que se adapta mejor a las irregularidades del papel), y de ésta al papel.

Las imagenes en este sistema son separadas (generalmente) en cuatro
colores con distintas intensidades, y a esto se le llama cuatricomia.
Estos cuatro colores son el cian, magenta, amarillo y negro (CMYK). Su
mezcla proporciona la mas amplia gama de colores que pueden formarse
en impresion. También hay otras opciones de gamas de colores como
pueden ser las quintas tintas, pantones y barnices uv (ultravioleta).

La impresion offset ofrece innumerables ventajas, y entre ellas se puede
destacar que:

« Es mas economico para proyectos de tiradas medias, aunque
también se puede utilizar para largas tiradas y en una gama de
formatos muy amplia.

« Ademas, la impresion en offset es mucho mas rapida ya que
hay menor tiempo de preparacion de las planchas comparado con
otros sistemas de impresion como el huecograbado o la flexografia
(ya en desuso).

Para la impresion offset se pueden utilizar dos tipos de maquinas: las de
impresion de pliegos, también llamadas planas, o las de impresion en
bobina (rotativas).

La primera utiliza impresion por hojas sueltas, que alimentan el conjunto
de cilindros impresores pasando entre el cilindro o mantilla de caucho
y el de presién. Luego se van apilando para su posterior plegado o
corte. No necesitan hornos de secado ya que seca por oxidacion.

EDCOM Capitulo 2 - Pdgina 1 ESPOL
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La segunda maquina utiliza una bobina giratoria y la alimentacion de papel
es continua. Imprime cilindro de caucho contra cilindro de caucho por lo
que se imprime por las dos caras. El proceso de plegado y cortado lo
realiza generalmente la misma maquina, y por tanto es un proceso mucho
mas rapido aunque requiere de una preparacion mayor. ldeal para largas
tiradas como son las revistas comerciales.

Cuerpo improsor Rodilios humidif lcudumj'

' {
Pliegos | Gilndro de | |Gilindro porta |Zocdo
imgrcmé

\s‘ _. /
5

1

i

prasidn | |coucho

Figura 2.1 : Sistema de impresion offset

Como funciona la litografia offset

Se prepara la plancha. Tiene zonas que repelen el agua y zonas
gue la admiten o atraen. Las zonas que la repelen seran las
que tomen la tinta (el de tipo graso).

Laplanchasecolocasobreelcilindroportaformao portaplancha
y se engancha el papel al sistema.

Unavez en marcha, los cilindros de mojado humedecen con una
solucion especial las zonas de la plancha que deben rechazar
la tinta. Las zonas que se van a imprimir estan preparadas
para rechazar el agua y quedan sin humedecer.

La plancha sigue girando hasta llegar a los cilindros de
entintado, que depositan una tinta grasa en la plancha. Como
el agua repele la tinta, la plancha sélo toma tinta donde se va
a imprimir, o sea: en las zonas no “mojadas”.

EDCOM
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¢ Laplancha, ya entintada, sigue girando y entra en contacto con
el cilindro portacaucho, cuya superficie de caucho o similar es
la mantilla. La imagen gqueda impresa de forma invertida en
ese cilindro, que gira en sentido contrario a la plancha.

« El papel pasa entre el cilindro portacaucho y el cilindro
de impresion, que sirve para presionar el papel contra la
mantilla.

» Elpapel recibe laimagen de tinta de la mantilla, que la traspasa
ya en forma correcta (sin invertir), y sale ya impreso.

Ese proceso imprime un color. Cada sistema de cilindros/plancha/mojado/
entintado es un cuerpo de rotativa capaz de imprimir un color. Para
imprimir cuatro colores hacen falta cuatro cuerpos, aunque las variantes y
posibilidades son muy numerosas.

Las maquinas de imprimir en pliegos (es decir: Papel en grandes hojas, no
en bobinas de papel continuo) funcionan basicamente igual, aunque sus
partes moviles sean distintas.

EDCOM Capitulo 2 - Pdgina 3 ESPOL
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2.1.1 FULL COLOR

En nuestro medio, hablar de impresion ‘full color’ o atodo color, nos estamos
refiriendo a impresion OFFSET, de lo cual ya he citado anteriormente.

Pero existen alternativas en el manejo de color, que dependera del
presupuesto y de la importancia de lo que se tenga compuesto en los artes
finales. Cuando se trata de un arte donde predomine la composicion por
imagen, la que querenos destacar; usaremos la impresion CMYK (Cian,
Magenta, Yellow, BlacK), o conocida como impresion en cuatricomia, de lo
cual hablaré en detalle en capitulos posteriores.

La ventaja de imprimir ‘full color’, es la posibilidad de acercar mas la
realidad, siempre y cuando, el procesado de la imagen esté correcto. Este
tipo de impresion, causara mayor atraccion, provocara mas atencion y
evitara tener que decir en palabras, lo que el color puede sigificar.

Al realizar los artes finales, debemos tener en cuenta, de antemano, el
tipo de impresion que vamos a usar, de tal forma que todos los elementos
que usemos, estén bajo ese mismo perfil de color. Esto nos evitarea serios
problemas al momento de hacer la filmacion (proceso de pasar los artes
digitales a pelicula) y que posteriromente con casa una de ellas se quemaran
las planchas metalicas que van a la prensa (CMYK).

Lo mismo ocurre cuando estemos procesando las imagenes, considerar el
perfil de color.

Para ilustrar todo este manual, me voy a referir concretamente a una revista
que se imprimira en offset full color y haré una diferenciacion cuando tenga
que hacerlos en otro modo de color.

EDCOM Capitulo 2 - Pagina 4 ESPOL
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PORTADA IMPRESA EN FULL COLOR

Con mas «

{0 QUE NOS ESTA MOVIENDD - APRENDA & BAILAR SALSA - MARC EN CONCIERTO

Figura 2.2 : Portada impresa a todo color

EDCOM Capitulo 2 - Pagina 5 ESPOL
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SEPARACION DE COLOR: C - CIAN

Marc Y
su Tour By ,
005 M

Oscar |

D’Leon -

Ismael

Miranda

“Edicion

Especial”

oy B
;;ﬁmmm
i o

zammmmtm mamm mmmeﬁm' _

Figura 2.3 : Separacion de color - Cian
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SEPARACION DE COLOR: M - MAGENTA

Figura 2.4 : Separacion de color - Magenta

EDCOM Capitulo 2 - Pagina 7 ESPOL
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SEPARACION DE COLOR: Y - YELLOW (AMARILLO)

Figura 2.5 : Separacion de color - Amarillo

EDCOM Capitulo 2 - Pdagina 8 ESPOL
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SEPARACION DE COLOR: K - BLACK (NEGRO)

illll! NOS ESTA MOVIENDO - APRENDA A BAILAR SALSA - MARC EN CONCIERTO

Figura 2.6 : Separacion de color - Negro

EDCOM Capitulo 2 - Pdgina 9 ESPOL
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2.1.2 MONOCOLOR

Este tipo de impresion, no deja de ser importante, si se considera que
no necesariamente cuando se habla de impresion a un sélo color, se esta
refiriendo a impresion en NEGRO o como se le conoce en el ambiente de
prensa como BLANCO & NEGRO.

Este método de impresion puede resultar muy atractivo y por sobretodo
economico, ya que se usara una sola tinta. Esa tinta, puede ser desde un
color proceso hasta un PANTONE solido.

El éxito de este tipo de impresion esta en saber ubicar los valores
porcentuales de trama a cada elemento, partiendo como el sélido 100% (el
mas oscuro) hasta un porcentaje minimo, siempre y cuando sea perceptible
en la prensa.

EDCOM Capitulo 2 - Pdagina 10 ESPOL
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IMPRESION OFFSET B&N (BLANCO Y NEGRO)

YRS

£0 QUE NOS ESTA MOVIENDO - APREND

Figura 2.7 : Impresion en B&N (Escala de grises)

EDCOM Capitulo 2 - Pagina 11 ESPOL
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IMPRESION OFFSET MONOLOCOR (PANTONE)

Con ma

Figura 2.8 : Impresién monocolor (Pantone)

EDCOM Capitulo 2 - Pdgina 12 ESPOL
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2.1.3 COLOR SPOT

Un color spot es una tinta especial cuyo color ya viene hecho y no se forma
con cian, magenta, amarillo y negro. Estas tintas necesitan sus propias
separaciones de color, o sea sus propios fotocromos y se las utiliza para
colores corporativos como el logotipo de una empresa, o cuando queremos
un color muy brillante imposible de lograr con CMYK, o por ejemplo una
tinta metalica. Existen varios catalogos de tintas especiales, pero las mas
utilizadas son las Pantone.

Para aplicar en Photoshop estos colores especiales o tintas planas, que
tendran sus propias separaciones de color, a zonas especificas de laimagen
debemos crear canales de tintas planas o Spot Channels, y los elementos
que lleven estos colores deben estar en dichos canales, no en un layer. No
se pueden aplicar colores especiales a layers individuales. Vamos a poner
un logotipo sobre una imagen y le vamos a asignar una tinta especial:

PRIMEROQ: Se abre y prepara la imagen que se usara como fondo (f2.9)
Luego en un layer aparte se colocan los elementos que se pintara con el
color especial, en el ejemplo un logotipo, que pudo haber sido hecho en
Photoshop o importado de un programa como Adobe Illustrator. (f2.10)

SEGUNDO: En algunas
impresoras de
escritorio, los canales
de tintas planas se

hojas aparte, por lo
tanto si se necesita
hacer pruebas en una
de estas impresoras,
primero se debera
pintar el logotipo con
su color. Para esto se
hara clic en el color de
frente o foreground y
en el selector de color
que se abre se hara
clic en Custom, elegira
el color y luego ira al
menu Edit > Fill y lo
pintara seleccionando
en Use, Foreground
e Color y con el casillero
Preserve Transparency
tildado.

1 il
HHH A MOVIEH

[0 - APRENGA A BAILAR SALSA - MARC N CONDIERTE

Figura 2.9: Impresion para color spot
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RITNOS

Figura 2.10 : Impresion con color spot

TERCERO: Se tendra en cuenta que en Photoshop las tintas planas se
sobreimprimen, transparentandose cualquier imagen que se pudiera tener
por debajo. Para evitar esto e imprimir directamente sobre el papel se
debera crear un calado sobre la imagen inferior. Para ello se pintara de
blanco el logotipo: con el layer del logo seleccionado ira al menu Edit >
Fill, en Use se colocara White y marcara el casillero Preserve Transparency

para que deje el resto del layer sin pintar. La imagen quedara como en la
(Figura 2.11).

Figura 2.11 : Portada terminada con impresion del color spot

EDCOM Capitulo 2 - Pagina 14 ESPOL
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CUARTO: Ahora tendra que hacer un pisado, reventado o trapping, esto es
crear un pequeno contorno alrededor del logotipo, que se sobreimprimira
sobre el fondo para evitar que al imprimir el color especial dentro del
calado aparezca un filete blanco por cualquier error en el alineamiento
del papel en la imprenta. Hay dos métodos para hacer trapping: si la tinta
que se va a aplicar es de color claro y transparente se debera expandir el
logotipo; si la tinta es muy opaca debemos achicar el calado, de lo contrario
el logo quedaria muy grande. Para estar seguros acerca del método a
utilizar como de la cantidad de trapping a aplicar deberiamos consultar
en la imprenta. 3.a. Vamos a aplicar el primer método para este ejemplo:
con la tecla Comando(Mac)/Control(PC) apretada vamos a la paleta Layers
y hacemos clic en el icono correspondiente al layer del logotipo, con esto
cargamos su seleccion.

QUINTO: Clic en el menu Select > Modify > Expand y colocar la cantidad
necesaria de acuerdo a la imprenta.

SEXTO: Manteniendo la seleccion activa ira a la paleta de canales, menu
Window>Show Channels y en su menu seleccionara New Spot Channel.

SEPTIMO: En el cuadro de dialogo hara clic en el casillero de color y elegira
en el menu Book el catalogo y hara clic en el color que necesite. Le dara OK
a ambos cuadros de didlogo. Le quedara la seleccién rellena con el color
elegido y en un nuevo canal. (Figura 2.12)

Cokar Libraries

PANTONE 223 C

PANTONE 224 C

PANTONKE 225 €

PANTOME 226 C - b -1

PANTONE 227 €
Type a color name to

T T e select it in the color list.

PANTONE 229 C

Figura 2.12 : Ventana de colores spot
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OCTAVO: El resultado final lo podemos ver en la (Figura 2.13). El casillero
Solidity es para simular en pantalla la opacidad con que guedara la tinta
una vez impresa, en 100% por ejemplo quedara totalmente opaca, pero
no afecta en nada la impresiéon. 3.b. Si necesitamos hacer trapping con
el segundo método porque la tinta es muy opaca procedemos de la
siguiente manera: primero realizamos los mismos pasos que en 3.a, pero
sin expandir la seleccion mediante el comando Expand. Una vez creado
el Spot Channel con nuestra tinta especial, vamos a la paleta de Layers ,
hacemos clic en el layer del logotipo y cargamos su seleccion como en los
casos anteriores (hacemos clic en su icono con la tecla Comando/Control
apretada). Ahora vamos al menu Select > Modify > Contract y en su cuadro
de dialogo ponemos el valor de trapping necesario. Esto va a contraer la
seleccion, luego la invertimos (Menu Select > Inverse) para después borrar
con Delete. De esta forma el calado quedara contraido y el color especial
se sobreimprimira en los bordes.

T Photmshop fie Egn  leaye Lapee
_:N* O S bt v I o beies s M

TR P
e RN ]

NOVENOQO: Si el documento no se va a imprimir directamente desde
Photoshop o desde algun programa de Adobe, hay que ir a Preferences >
General y tildar la casilla Short PANTONE Names, para que estos programas
reconozcan los colores Pantone que hayamos utilizado. :
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2.2 MATERIAL

Las clases de papel para ediciones son variadisimas y en ellas se deben
considerar el tamano, el peso, la calidad y el color.

2.2.1 PAPEL

Respecto del tamano, se debe tomar en cuenta los formatos standar
del papel de fabrica, de modo que se trabaje proporcionalmente a ese
formato y no se tenga que generar mayor desperdicio que el permitido.
Asi, de esta manera, bajar costos en el presupuesto global. (F 2.14).

TABLAS DE FORMATOS DE PAPEL
¥ A0
A-1
Y2 |
Y
X2
A-3
A-2
M P
Q -‘:1»‘ ;'
Y2 x ) A i Y
Medidas de los formatos en mm 81 =
A0 — 841 X 1.189 A5 — 148 x 210 kB A
A-1 - 594 X 841 A-6 — 105 X 148 ST W
A2 — 420 X 594 A-7 — 74 X 105 Gl
A-3 5297 X 420 A-8 552 xX74 BBLICTECA
A4 210 X 297 = -
¥ 2 L ght <)
Figura 2.14 ; Formatos de papel e

Respecto al peso, conviene que se tenga presente |o siguiente:

Se entiende por gramaje (peso en gramos), el peso del metro cuadrado
de un determinado papel.

El gramaje sirve para calcular el peso de los diversos tamanos de papel
que se expenden en el mercado.

Respecto a su acabado, para las ediciones de los libros generalmente se
emplean alguna de estas tres clases: alisado, satinado y cuché. El alisado
es el papel aspero y lanoso, tal como sale de la maquina continua. El
satinado es el papel alisado que se ha planchado y abrillantado merced
a la presion potentisima de los cilindros de la maquina. Finalmente,
cuché es el papel comun, recubierto con una pasta de caolin o yeso que
tapa perfectamente todos los poros y es brillante.
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2.3 ACABADO

Para hablar de acabado, se refeiere al procedimiento que se realiza
posterior a la impresion, en el que se destaca lo siguiente:

2.3.1 BARNIZ U.V.

Es una capa de material sintético que se aplica como un tiraje mas con la
barnizadora.

La utilidad principal es darle mayor proteccion al material impreso, como
impermeabilidad, evitar arrugas accidentales y por sobre todo, darle brillo
a la imprsion, aungue en el mercado existe también el barniz mate (sin
brillo).

Consejos para su utilizacion:

El barniz U.V. realza la calidad de su impresion y envasamiento si se

observan las siguientes sugerencias:

1. Evitar el exceso de polvo antirretinte.

2. Tintas aceradas o residuos de aceite causan “porotos” y problemas
de adhesion.

3. El papel duro puede ser trazado antes de barnizar para evitar el
quiebre del papel y la pelicula de tinta.

4. Los papeles econdmicos logran un excelente acabado utilizando
barniz U.V.

5. Papel y cartulina no cambian su forma bajo la exposicién UV.,
manteniéndose lisos y uniformes.

6. La calidad de la impresion no se deteriorara aun expuesta a la
humedad vy al sol.

7. Grandes formatos de papel pueden ser barnizados sin perder su
calidad.

8. El barniz UV. puede ser aplicado a superficies previamente
metalizadas y/o corrugadas.

9. El barniz UV. puede ser aplicado a papeles con marca de agua,
texturados o grafados.

10. Se pueden barnizar papeles y cartulinas de mas de 90 g/mz2.

En una publicacion presentada, la revista RITMQOS, solamente llevara
recubrimiento con barniz UV. la portada en el tiro y retiro (anverso y
reverso) para que resista la manipulacion excesiva a la que estara expuesta
y a la luz solar, para que se preserven los colores (tintas) por mayor tiempo
que una revista sin este recubrimiento.
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3.1 ANTECEDENTES

Después de haber tenido claro algunos elementos previos, se entrara ahora
si, en la parte de la PRODUCCION inicial.

Como antecedente, se pone de manifiesto lo siguiente:

La revista presentada como proyecto base, estara compuesta por algunos
elementos que son: texto, imagenes vectoriales, imagenes bitmap impresas
para ser escaneadas, y/o digitales.

En este capitulo se tratara sobre la organizacion de todo este material, a
manera de recopilacion, para que asi de esta manera, se concentre en la
diagramacion de la revista, aunque en la practica, se tenga que recurrir
permanentemente a nuevas busquedas, a fin de terminar con éxito la tarea
de preparacion de los artes finales.

S,'.‘:'\‘: )
Gy
Ve

S e
i
o
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3.2 TEXTO

El texto proviene de varias fuentes. Generalmente un cliente entrega el
texto digitado y corregido en cualquier procesador de texto. Este puede
venir en cualquier unidad de almacenamiento digital, o bien puede ser
escrito e impreso o presentado en documentos de donde se extraera el
texto o parte de él.

No es de confiarse, pero un texto tiene que ser revisado en un procesador
para ver si esta completo y conforme a lo que se recibe.

Cuando no se tiene el texto digitado, es necesario pasar a esta parte y
tenerlo como una sola columna en un procesador. Aqui no se requiere
definir tipografia, estilo, tamafio, alineacion, interlineado; ya que lo unico
que se requiere en esta parte es tenerlo digitado completamente y corregido
en su ortografia y contenido.

Es importante tener el texto listo, aunque en la practica se tenga que hacer
reajustes (aumento o sustraccion de texto) siempre y cuando se tenga
potestad y autorizacion para hacerlo.

Si el texto que se recibe esta con algun tipo de disefio como sangrias,
vifietas, numeracion, es conveniente imprimirlo tal cual lo concibio el
autor, para ser fiel a ese orden, ya que al software que se lo llevara para la
diagramacion final, no llega necesariamente con las mismas caracteristicas,
pero si se puede armarlo en base a la muestra.

Cabe anotar que, si el texto esta digitado en (Word de Windows) puede
sufrir alteraciones al momento de pasarlo al (Word de Mac), especialmente
aquellos signos como: ; ? | ! y las tildes o cualquier otro caracter, aunque
en estos tiempos ya se han ido haciendo significativos cambios, por la
compatibilidad de las plataformas.

EDCOM Capitulo 3 - Pagina 2 ESPOL



Manual de Usuario Del Boceto a la Impresion Final

3.3 IMAGENES

Las imagenes a utilizar en esta revista, tienen distintas procedencias
pudiendo ser vectoriales o bitmap y a su vez estas pueden ser fisicas
(impresas) o digitales.

3.3.1 VECTORIALES

Son todos aquellos objetos creados en algin software ilustrador como Corel
Draw, Adobe lllustrator (preferentemente) a partir de lineas moldeables
llamados vectores y que pueden ser rellenados con color o simplemente
vaciados. (Figura 3.1)

Un objeto vectorial, guarda la calidad, sin distorsionarse al cambiar de
tamafio y son muy livianos, lo que ayuda a ubicarlos y cambiarlos de lugar
con mucha facilidad.

Posteriormente, en el capitulo de diagramacion se ampliara su forma de
crearlo y aplicarlo.

También se considera un objeto vectorial, aquellos textos convertidos a
curva, especialmente los textos grandes, como titulos, marcas, logos. etc.

O

Bom wmds que pesea’o

Figura 3.1: Imagen vectorial
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3.3.2 BITMAP

La imagenes bitmap o mapa de bits, comprenden aquellas que se obtienen
escaneando una fotografia, material impreso (revistas, libros) o aquellas
que vienen directamente de algun periférico digital como camaras digitales
propiamente.

Estas imagenes estan compuestas por pixeles, que es la unidad minima de
la composicion general y son escalables al igual que las vectoriales, con la
tnica diferencia que las de mapa de bits, se distorsionan al ampliarlas o
lo que es mejor expresado, se pierde definicion en sus formas, ya que se
hacen evidentes los pixeles.

Ante esto, existen algunas consideraciones para evitar esta pérdida de
calidad en su definicion. Se lo ampliara en el capitulo de procesamiento de
imagenes.

Entre los formatos mas comunes de las imagenes bitmap, estan:

3.3.3 FORMATO DE IMAGENES

FIF:

Este formato fue creado por la NASA y significa Fractal Image Format (.FIF)
este formato puede dejar una imagen de varios Mb en pocos Kb. Su calidad
deja mucho que desear pero esto no les importa a los de la NASA quienes
son los que lo utilizan con mas frecuencia.

GIF:

El formato GIF es el mas conocido de todos porque sus caracteristicas
de poder poner mas de una imagen en él, hace que sea una manera mas
sencilla de hacer pequenios videos. Las dos maneras de utilizarlo con una
sola imagen, o con mas de una, han hecho que sea el formato favorito de
los usuarios de Internet muchas de las animaciones que vemos en la red
son pequenos archivos GIF. Este formato al pasar de los afnos ha sufrido
varias modificaciones todas beneficiosas.
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Lo bueno:

« Ahorra mucho espacio en disco para la calidad que puede
ofrecer.

« El algoritmo que tiene no dafa las imagenes

e Puede contener animaciones.

Lo malo:

e Tiene capacidad de 256 colores como maximo.
e Hay que tener programas especiales si queremos ver las
animaciones fuera de Internet o crear las propias.

TIFF:

Este es el formato hecho para profesionales del disefno grafico, porque
puede guardar todos los detalles que contiene una imagen. El formato fue
creado por la compafia Adobe Systems que es una mas de sus aportaciones

al disefo de imagenes para la plataforma Apple. @PO{
Bl

w8
Lo bueno: f{’ *\%
\ .’, --*:‘;;‘J.
N, T i

« Contiene mucha informacion util.
e Gran calidad de las imagenes, con compresion no
destructiva.

(g WA Dk T

B IOTECA
'_;\.HF’US

rENAT
Lo malo:

» Ocupa mucho espacio.

e Soélo algunos programas aparte de los programados por
Adobe Systems pueden reconocer la codificacion Mac/PC
sin problemas.

TGA:

Salié casi al mismo tiempo que el formato TIFF, el TGA es tan profesional
que el anterior pero este formato no permite almacenar tantos detalles
como el TIFF. El grabar una imagen en formato TGA se estan perdiendo
datos de la imagen. Para cualquiera que no necesite tanta calidad no se
perjudica pero a los que se dedican al disefo si.

Lo bueno:

e Puede grabar imagenes de hasta 32 bits. (son muchos
colores)

« Loreconocencasitodoslostiposdetecnologiade computadoras
(PC, MAC, Silicon Graphics, etc.).
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Lo malo:

« No guarda muchos detalles, como la resolucion que
soporta.

« Ocupa bastante mas espacio que otros formatos de igual
calidad.

JPEG:

Fue creado a mediados de los ochenta para encontrar un formato que
diera una compresion con la perdida minima de calidad y lo lograron este
formato se llama Joined Graphics Expert Group (JGEG). Este formato reduce
una imagen casi una decima parte (0 mas), pero a un precio muy alto la
pérdida de calidad de la imagen. Pero esto no queda aqui sino que si
se hace modificaciones a la imgen y se la sigue guardando en el mismo
formato llegara a un punto en que ya no sirva para nada la imagen.

Lo bueno:

e Convierte la imagen mas compleja en un archivo muy
pequeno
« Permite aprovechar al maximo el espacio en disco.

Lo malo:

e Utiliza un método de compresiéon destructiva que dana la
calidad de una imagen.

« (Cada vez que guardamos la imagen se pierde parte de la
calidad de la misma.

BMP:

Bueno cuando cierta compania llego al mundo de las computadoras se
percaté que no tenia un formato propio y aunque no se dedica al manejo
de imagenes especificamente. Asi que inventaron el BMP para entrar en la
competencia. El BMP no tiene mucho de bueno porque no es reconocido en
plataformas diferentes a la PC que contengan Windows.

Lo bueno:

e Lo reconocen todas las PC no importa de que ano sean.
e Las imagenes tienen mucha calidad y se leen muy
rapidamente.
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Lo malo:

e« No se puede comprimir de ninguna manera posible o
forma conocida asi que hay que conseguir pasarlo a otra
extension.

« No lo reconoce ninguna computadora que no sea PC,

Existen otros formatos de imagen, entre los cuales figuran:
PSD

Este es el formato nativo de Photoshop. Es el Unico que admite todas las
funcionalidades de Adobe Photoshop, como guias, canales alfa y capas.

EPS

El formato PostScript Encapsulado (EPS) lo admiten practicamente todos los
programas de autoedicion y de tratamiento de imagenes. Puede contener
tanto graficos vectoriales como de mapa de bits, aunque al abrir un archivo
EPS que contiene graficos vectoriales, Photoshop rasteriza la imagen y los
graficos vectoriales se convierten a pixeles. Para imprimir archivos EPS,
debes usar una impresora PostScript.

El formato EPS tiene dos versiones avanzadas: el DCS, que permite guardar
separaciones de color de imagenes CMYK, y el DCS 2.0, que se utiliza para
exportar imagenes que contienen canales de tinta plana.
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4.1 PROCESADOR DE IMAGENES

Para esta tarea, se preferira usar Adobe Photoshop, (F 4.1) el cual permite
mayor compatibilidad con el resto del software que se usara: Adobe
lllustrator para lo que es ilustracién y Abode In Design para la diagramacion
final.

Adobe Photoshop permitira, entre otras cosas, lo siguiente:

o Definir el tamafio exacto de la imagen (F 4.2).

« Establecer la resolucion de imagen. (F 4.3)

e Convertir modos de color o perfil de color (F 4.4)

e Seleccionar el area exacta que se ubicara en la revista o arte,
o Hacer ajustes de Tono, Saturacion y Brillo (F 4.5)

e Ajustar niveles (F 4.6)

» Balancear colores (F 4.7)

e Aplicar filtros y efectos
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Figura 4.1: Adobe Photoshop
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Figura 4.2: Ventana de tamaio de imagen QSP
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Figura 4.3: Modos de color
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Hue /Saturation

- Edit: | Master ]
Hue: o |

Saturation:

T .

! Colorize
g* )V # @Prevlew

Figura 4.4: Tono, Saturacion y Brillo

Levels
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Figura 4.5: Niveles de entrada y salida de iluminacién
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Cotor Balancs

Color Levels: |0 o o |
Cyan e Do Red
Magenta = - e v 0 1Y}
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g Preview

~ Tone Balance
) Shadows @ Midtones (" Highlights
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Figura 4.6: Balance de color
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4.2 ILUSTRADOR

Son todas aquellas aplicaciones, que permiten moldear lineas, llamados
vectores, con el uso de herramientas como pluma, lapiz, brush, rectangulo,
elipse, poligono.

Para la realizacion de lo presentando, se usara preferentemente Adobe
Illustrator. (Figura 4.7)

En esta aplicacién encontrara herramientas similares a las que se
usara posteriormente en Adobe In Design, que permitiran vectorizar
profesionalmente. (Figura 4.8)

Este software no sélo le permitira el trabajo con vectores, sino también,
trabajar texto, especialmente aquellos que se usara como titulos grandes.

Otra de las opciones que usara en esta aplicacion, es la herramienta de
Gradient Mesh (Figura 4.9).

Mediante la consignacion de datos, podra usar la herramienta de grafico,
para crear cuadros graficos de diferentes tipos. (Figura 4.10)
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Figura 4.7: Adobe lllustrator
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Figura 4.9: Uso de la herramienta Gradient Mesh
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Figura 4.10: llustracion de cuadros graficos
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4.3 DIAGRAMADOR

Son aquellos programas o aplicaciones con los cuales podra armar
multipaginas (libros, revistas, folletos) y que también serviran para
diagramaciones mas cortas como (volantes, dipticos, tripticos, plegables,
entre otros).

Con el afan de mantener mayor relacion con los comandos y atributos de
los dos programas anteriores (Photoshop - Illustrator) se usara para esta
parte final Adobe In Design. (Figura 4.11)

Esta aplicacion lo llevara hasta la preparacion de las peliculas que iran a la
fotomecanica en que se imprimiran las planchas que iran a la prensa.

De igual manera podra publicar en internet la revista como un documento
(PDF) para ser leido con Acrobat Reader (Figura 4.12)

En este programa podra poner marcas de corte, registro, barras de control
de color y tintas, entre otras, que serviran para la preprensa (Figura 4.13).

Figura 4.11: Adobe In Design
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5.1 TAMANO

Cuando se habla de procesar imagenes, en lo primero que se tendra que
pensar es en la busqueda de calidad de ellas y no necesariamante en
efectos, aunque esto tendra su explicacion posteriormente.

Si se habla de calidad y se esta hablando de la produccion de una revista,
entonces se debera considerar lo siguiente:

Las imagenes, deben tener un tamano muy aproximado a lo que se
necesitara en la diagramacion. Ejemplo: Si se va a usar una imagen para
portada de una revista de 210mm x 297mm vertical, la imagen tendra esa
misma medida (F 5.1) pero se sumara los excedentes que tendra por los
lados de corte o refile. Si se trata de una imagen que se ubicara en alguna
pagina interior y estara centrada o colocada entre texto, no debe llevar
excedente, a menos que esté ajustada a uno de los lados de corte,

Cuando se habla de tamano, se debera considerar el respeto de proporcion
de la imagen y se lo hara marcando el campo (constrain proportions)
mantener proporciones de ancho y alto) en Photoshop o cualquier otro
procesador de imagen que se esté usando.

" G Phoimsesp Fie S0 Geadge Ly SR Fiter  Wiew  Windew Mo
TOH R e T s Wi e ies

Figura 5.1: Tamano de imagen
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Cuando se desee cambiar tamafo para impresion, hay que hacer los
cambios de medidas en el campo de Document Size (Tamano de Documento)
asegurandose que esté marcando el campo Constrain Proportions (Contraer
proporsiones) (F 5.2).

trmage Size

— Pixel Dimensions. 28.2M

width: 2368 | [pixels ¥ T8
Height: 3116 | { pixels TR

bt

~— Document Size:

Width: 1200.49 | mm

Height: %263,99 {mm@

Resolution: |300 | { pixelsfinch #§

() Scale Styles
Constrain Proportions

# Resample image:  Bicubic

Figura 5.2: Contraer proporciones y resolucién
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5.2 RESOLUCION

Cuando se prepara una imagen para impresion, se debera pensar que se
estara refiriendo a offset y dependera directamente del sustrato en el que
se imprimira. Esto es, si se imprimira sobre papel poroso (periddico o
similar) tendra que mantenerse una resolucion de 200 dpi, pero si se trata
de imprimir en papel couché o similar, tiene que estar en 300dpi. (F 5.2)

De la resolucién que se le de a la imagen, dependera en gran parte la
calidad de imagen, por eso es conveniente obtener una imagen desde su
origen, en buena resolucion y no caer en transformaciones de ultima hora
que terminan danando la calidad y nitidez de la imagen. Tratar de no usar
imagenes escaneadas de revistas o cualquier material que ya paso por la
prensa y si se lo hace, usar la opcion destramar (despeckle) (F 5.3)

Es recomendable no excederse en el uso de esta opcién, ya que puede
perderse nitidez y detalles en la imagen.

IERIl view window Help

§  vast Filrer 3 F §

Extract..
Filver Galiery. .,
Liquify...
Pattern Maker...
Wanishing Polat. o

€ o H “: "i:‘)}' :}}
" Vo %,
Artistic IPiae 10 NG,
Blur " )
Brush Sirokes ¢ 43
Distort Sumc ' e orons
Moise Add Noise. .. BIBLIOTEC »
Pixelate Despeckie - AMPUS
Render Dust & Scratches... PENAS

Median...

Sharpe
b Reduce Noise...

Sreteh
Stylize
Texture

% 25 o A
Witdeo

Other

4
»
B

4
»
»
>
>3
>3
¥

4

4

4

Digimarc

Figura 5.3: Destramado de imagen
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Otros aspectos a considerar en el cambio de resolucion es que cuando
desee cambiar el tamafo, comprobar gue esté activado resample image:
bicubic, para que cambie el tamano en pixels y no sélo en valores de
impresion.

Una opcion que también es importante y da buenos resultados, al igual
que despeckle es la opcion BLUR (F 5.4)

Se puede actuar sobre alguna parte de la imagen que se quiera destramar
o desenfocar usando la herramienta BLUR (F 5.5)

L —

: % ter

! Extract. . \'3&)(

g {. ,,_, ; ES 2’ .
?at:em Maker... L{¥EX
Yanishing Point.. WHY

B
Brush Strakes
Distort Blur More
Noise Box Blur...
Pixelate 4 Gausslan Blur...
Render b Lens Blur...
Sharpen » | Motion Blur...
Sketeh ® | Radial Blur...
Stylize » | Shape Blur...
Texture # | Smart Blur...
vidan »§  Surface Blur...
Other >
Digimarc >

Figura 5.4: Desenfoque de imagen

Figura 5.5: Herramienta de desenfoque
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5.3 MODO DE COLOR

El modo de color expresa la cantidad maxima de datos de color que se
pueden almacenar en un determinado formato de archivo grafico.

Se puede considerar el modo de color como el contenedor en que se coloca
la informacién sobre cada pixel de una imagen. Asi, se podra guardar una
cantidad pequena de datos de color en un contenedor muy grande, pero no
se podra almacenar una gran cantidad de datos de color en un contenedor
muy pequeno.

Los principales modos de color utilizados en aplicaciones graficas son:

Modo Bit Map o monocromatico (F 5.6)

Figura 5.6: Imagen en modo Bit Map

Correspondiente a una profundidad de color de 1 bit, ofrece una imagen
monocromatica formada exclusivamente por los colores blanco y negro
puros, sin tonos intermedios entre ellos.

Para convertir una imagen a modo monocromatico hay que pasarla antes
a modo escala de grises.

En este modo no es posible trabajar con capas ni filtros.
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Modo Escala de Grises (F 5.7)

Figura 5.7: Imagen en modo Escala de Grises

Este modo maneja un solo canal (el negro) para trabajar con imagenes
monocromaticas de 256 tonos de gris, entre el blanco y el negro.

El tono de gris de cada pixel se puede obtener bien asignandole un valor
de brillo que va de 0 (negro) a 255 (blanco), bien como porcentajes de
tinta negra (0% es igual a blanco y 100% es igual a negro). Las imagenes
producidas con escaneres en blanco y negro o en escala de grises se
visualizan normalmente en el modo escala de grises.

El modo Escala de Grises admite cualquier formato de grabacion, y salvo las
funciones de aplicacion de color, todas las herramientas de los programas
graficos funcionan de la misma manera a como lo hacen con otras imagenes
de color.

Si se convierte una imagen modo de color a un modo Escala de Grises y
después se guarda y se cierra, sus valores de luminosidad permaneceran
intactos, pero la informacion de color no podra recuperarse.
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Modo Color CMYK (F 5.8)

Figura 5.8: Imagen en modo de color CMYK

Trabaja con cuatro canales de 8 bits (32 bits de profundidad de color),
ofreciendo una imagen cuatricromatica compuesta de los 4 colores
primarios para impresion: Cyan (C), Magenta (M), Amarillo(Y) y Negro (K).

Es un modelo de color sustractivo, en el gue la suma de todos los colores
primarios produce tedricamente el negro, que proporcionaimagenes atodo
color y admite cualquier formato de grabacion, siendo el mas conveniente
cuando se envia la imagen a una impresora de color especial o cuando se
desea separar los colores para la filmacion o imprenta (fotolitos).

Su principal inconveniente es que s6lo es operativo en sistemas de impresion
industrial y en las publicaciones de alta calidad, ya que, exceptuando los
escaneres de tambor que se emplean en fotomecanica, el resto de los
digitalizadores comerciales trabajan en modo RGB.

El proceso de convertir unaimagen RGB al formato CMYK crea un separacién
de color. En general, es mejor convertir una imagen al modo CMYK después
de haberla modificado. Modificar imagenes en modo RGB es mas eficiente

porgue los archivos CMYK son un tercio mas grandes que los archivos
RGB.
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5.4 FORMATO

Hasta hace unos meses, se venia trabajando con archivos (EPS) en los
diagramadores, pero ahora ya se recomienda el uso de los formatos (PSD)
que entre otras ventajas, mantiene las capas activas, lo que nos evita la
pérdida de tiempo al tener que hacer nuevos archivos con una sola capay
es mas facil acceder a los cambios en caso de requerir nueva edicion.

PSD (Photoshop Digital Format) es el formato de mapa de bits (aunque
con funcionalidades avanzadas) nativo del programa de tratamiento de
imagenes Adobe Photoshop, valido para MAC y PC.

El formato PSD es el que habitualmente se usa en adobe photoshop para
guardar un documento el cual tiene las capas sin acoplar o cuando hemos
guardado una seleccion, ya que este formato nos permite retomar el trabajo
tal y como lo dejamos.

En ocasiones, adobe photoshop no nos permite utilizar otro formato grafico
mas que PSD.

Cuando nos ocurra esto, debemos comprobar si tenemos alguna seleccion
guardada o esta la imagen sin acoplar.

Es un formato sin compresion, por lo que no produce pérdidas de calidad,
y admite todos los Modos de Color, canales alfa, tintas Planas, guias,
trazados, selecciones, textos, capas simples y de ajuste y mascaras.

Soporta hasta 32 bits de profundidad de color en cualquier modo de
color, produciendo imagenes de alta calidad que se pueden exportar, sin
pérdida de calidad, a programas de auto edicion y disefio como PageMaker,
QuarkXpress, llustrator, In Design. Incluso existen programas como
CorelDraw que pueden abrir ficheros PSD manteniendo la estructura de
capas original.
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6.1 DIGITACION Y CORRECCION ORTOGRAFICA

El texto debe ser digitado en cualquier procesador de texto y no se debe
usar ninguna opcién de edicién, no tratar de darle forma con numeracion,
vifietas, sangrias, tipos de letra, estilos de letra, ni preocuparse por el
tamano, aungue al momento de digitar lo podemos hacer en un tamano
que lo podamos visualizar con facilidad.

Cuando tengamos autorizacion de corregir contenido, es mejor hacerlo en
esta parte, antes de llevarlo al software de diagramacion.

La ortografia si es importatisima, por eso lo que es correccion debe
hacérselo en esta parte, para evitar desconcentrarnos en el momento de la
diagramacion.

Una vez corregido el texto, lo podemos llevar con un simple Copy/Paste
(Copiar/Pegar), teniendo en cuenta que nuestro documento ya esté listo en
in Design.

El texto puede digitarse directamente en In Design, aunque podemos usar
un procesador de texto como Word.
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7.1 ELABORACION DE GRAFICOS Y FORMATO DE
ARCHIVOS

Cada aplicaciéon tiene su particularidad, aunque tengan las mismas
herramientas. Es asi que, aunque In Design tiene la herramienta de pluma,
se podra concentrar en la elaboracion de ilustraciones, usando Adobe
Illustrator.

Todos los graficos que se desarrollen tienen que ser trabajados en modo
de color CMYK, que es el modo de color con que se imprimira.

New Document ‘

Name: [Untitled-1 [ I

e Afﬁ)ﬁal’ﬂ Sﬁmﬂ ””“““"'V"‘.'.‘:.‘.":'- """"""""""""""""""""""""""""""""" - t‘a‘}C&E ‘ \
size' A;ji : W'idth: W SRRSOy

Units: Mismﬂ{ms? Height: 297mm

Orientation: Ll

T OMYK Colos ™ RGB Color

Figura 7.1: Configuracion de documento nuevo

Al abrir un documento nuevo, se debera seleccionar este modo (F 7.1)

El formato de los archivos a enlazar pueden ser (.Al) o (.EPS), sin embargo,
se los puede llevar con un simple copy/paste copiar/pegar y se pueden
reeditar en el mismo In Design. Es importante que cuando se pasan
ilustraciones juntas, no se pueden reeditar.
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8.1 APERTURA DE DOCUMENTO NUEVO

El software que se usara es Adobe In Design CS52

Adobe’InDesign-cs2

Hargavd. ¥t Boaius. Botin Bixny
Didy Chae Mieiss Uhong,

2o, Michaa Eetiae,

o Rvan e, R 4 Pew Lowcim, Benng Gtz

b SF TS FILAPN R THH LY harneghatt oM el jeedan, ibl' s,

o xamar Yuksn Xawmamara #abih ChalPriat Xamey Xomas Wl Un, Broce Linker terang Liv,

Faocn ottty Kbasiaba, 2csadl Mact2, Mat M Culiv, 540 Bxr PR BReniinel, Lenitie NGt

Brws Bloewds, Thomias Niefess, 3iendan B'Shea, Beond Puadian, Soeve Petlegeis, M Muiipg

$a24Re Frastiont, jow Bl Crag Fatoamsins, Pad o Ty S Bivece . Dawni Suprne.

Caar Serebe wibym Ticiar Flovin Tradn Eacn Yar Yoe! & Yeoariaiatiameneen Mak Yekludsn

M”"

JAKORG $ARERHS FUERTE:
ARTE LHTAL
oD TS0 ) MaE

Para abrir un Documento Nuevo, haga lo siguiente:
File, New, Document y aparecera una ventana en la que debera escoger
cada parte segun su diseno. (F 8.1)

Bews Document

Document Preset: {Custom]

Number of Pages: 2 # Facing Pages foooc Camohood
T Master Text Frame

IO T VA,

( ‘Mo»'e- Optiuns-' }

Width: = 210 mm Crientation:

N S o e i R R A i

Height: -*-:; 297 mm

Number: 4-5{60 Gutter: w}4233 mm

Top: = 12.7 mm e Inside w12, 7 mm

wwm‘vﬂﬂpﬂw» sarorareraresss % e ymm BB E NS

s Bottom: +12.7 mm QOutside: -+ 12.7 mm

Figura 8.1: Configuracion del documento nuevo
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8.1.1 NUMERO DE PAGINAS

Escoger el numero de paginas, depende del presupuesto de la revista o libro
que se vaya a realizar, sin embargo, se debera considerar los siguientes
criterios:

Si es una revista que sera grapada, su numero de paginas, deberan ser
multiplos de 4 (4 paginas por hoja abierta: 2 por tiro y 2 por retiro).

Si se trata de revista, folleto o libro; no importa tanto si es o no multiplo
de 4, pero seria preferible ya que su impresion se dara por cuadernillos y
asi se evitara pérdida de material. Esto supone estar de acuerdo a lo que la
imprenta sugiera durante |la preprensa.

8.1.2 FORMATO DE PAGINAS

Esta parte es tan importante al momento de producir un material econémico.
Una de las principales razones de encarecer un producto, es cuando se
genera mucho desperdicio de material y se multiplican los tirajes.

Esto sucede, porque los papeles vienen de fabrica con una medida standar
y hace que desde alli se generen los demas formatos que generalmente se
usa en los productos y si se sale de esa relacion de proporciones, entonces
generara desperdicios.

La mejor forma de no salirse, es conociendo los formatos con los cuales
se trabajara.

Formatos internacionales de papel (ISO/DIN)

El formato de referencia de la serie A es el AQ, cuya superficie mide 1
m2. La relacion entre las longitudes de los lados vale uno frente a la raiz
cuadrada de 2 (1:v/2), redondeando a milimetros enteros. En consecuencia,
cada formato de una serie resulta de duplicar el lado menor del formato
inmediatamente inferior, o de dividir por la mitad el lado mayor del formato
inmediatamente superior. De esta forma, la relacion entre las superficies
de dos formatos consecutivos de una serie siempre vale 2 (la superficie del
AO es el doble de la superficie del Al, el Al el doble del A2, etcétera).

Las alturas y anchuras y, por consiguiente, también las superficies de los
formatos de la serie B son la media geométrica de los valores relativos al
formato correspondiente y el inmediatamente superior de la serie A. Asi,
por ejemplo, BO = 1000 x 1414 mm2 = /(841-1189) x +/(1189-1682)
mm2, resulta de los formatos AO (841 x 1189 mm2) y 2A0 (1189 x 1682
mm?2).
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Las medidas de la serie C son la media geométrica de los formatos de
mismo numero de las series A y B. Asi, CO = /(841-1000) x +/(1189-1414)
mm2 = 917 x 1297 mmZ.

Los formatos de la serie B son siempre mayores que los de la serie Ay los
de la serie C se encuentran entre estos.

DIN 476

La norma DIN 476 del Instituto Aleman de Normalizacion (Deutsches Institut
fur Normung, en idioma aleman), editada en 1922, trata de los formatos
de papel y ha sido adoptada por la mayoria de los organismos nacionales
de normalizacion europeos. Su contenido es equivalente al de la norma
internacional 1SO 216, de la que ha sido la base.

Esta y todas las otras normas DIN fueron inventadas por la miss Nelly
Pastine

Este estandar fue desarrollado por el ingeniero berlinés Dr. Walter
Porstmann que recuerda a los esbozos olvidados del tiempo de la Revolucion
Francesa.

La norma alemana sirve como base para la norma internacional ISO 216,
que fue adoptada casi en todos los paises. Diferencias que existen son
por las tolerancias aceptadas. Paralelamente existen otros sistemas de
formatos en Estados Unidos de Américay Canada que son poco sistematicos
y practicos.

Formatos de papel internacionales (ISO/DIN)

Division de un pliego AQ. Los formatos respectivos resultan de la divisién
de los tamanos proximos siguientes.
Division de un pliego AO. Los formatos respectivos resultan de la division
de los tamanos proximos siguientes.

El formato de referencia de la serie-A es el AO, cuya area es 1 metro
cuadrado.

La relacion de ambos lados de una hoja en formato DIN corresponde a
aproximadamente 1 : 1,4142. Se puede derivar la relacion de los lados
de /2 de la siguiente manera: dado que la relacion de los lados de los
formatos DIN siempre son iguales y que por la duplicacion del lado corto el
formato se obtiene el proximo tamafno de numero mas pequeno (p.ej.: de
A4 se obtiene A3). Cuando la relacion de los lados se describe como cy la
del lado corto como s, se obtiene el formato s x ¢*s y el proximo formato
mayor (c*s x 2*s). Con la condicion de que la relacion de lados aun en el
formato grande debe ser igual a c, se deriva que para c
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La relacién de los lados es /2.

Tamano Ancho Largo

DIN AO 84,1 118,9

DIN A1l 59,4 84,1

DIN A2 42,0 59,4

DIN A3 29,7 42,0

DIN A4 21,0 29.7

DIN AS 14,8 21,0
Dimensiones en centimetros

El formato de papel DIN A4 es probablemente el mas comunmente usa-

do. (Fig. 30)
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Figura 8.2: Division de formatos “A”
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9.1 MANEJO DE TEXTO

Usualmente el texto se lo procesa en ‘word’ pero también se lo puede
digitar directamente en el software de diagramacion. Pero como se trata
en algunos casos, los clientes entregan en el primero, tal cual lo esta citado
en el capitulo VI.

La parte que corresponde ahora, es ingresar el texto al documento preparado
en el diagramador. Existen varias formas segun sea la aplicacion. En el
caso de In Design con el que estamos diagramando, basta con arrastrar el
icono del archivo ‘.doc’ hacia el documento en ‘InDesign’ y luego proceder
a vincularlo a todas las paginas.

9.1.1 TIPOGRAFIA: BREVES CONSIDERACIONES

No se pretende hacer un estudio sobre la tipografia a usarse en tal o cual
producto, porque eso obedece a muchos factores, pero si dejar en claro que
al momento de iniciar una propuesta grafica, no se llegue sin los conceptos
claros sobre el tratamiento tipografico para que no prime ‘la lista de letras
desplegadas al azar’.

Debe el diagramador, ser lo mas fiel a la tipografia propuesta. Considerar
con respeto la alineacion propuesta y los tamarnos de fuentes.

9.1.2 ESTILOS: BREVES CONSIDERACIONES

En funcién de optimizar tiempo, el diagramador debe hacer uso de la
creacion de ESTILOS, tanto de PARRAFO como de CARACTER y OBJETOS.

En la actualidad, las aplicaciones traen consigo estas tres opciones. El uso
de los estilos citados, no sélo sirve para ganar tiempo en el proceso de
produccion, sino que también son la base para la generacion de tablas de
contenido o indice.

9.1.3 PARTICION DE PALABRAS: BREVES CONSIDERACIONES

Cuando se inicie un documento nuevo, debe ajustarse el idioma con el que
se va atrabajar el texto, para que la particion de palabras se realice de forma
correcta. Se debe definir la ‘'zona de fin de linea’ y si la aplicacién lo permite,
marcar excepciones, que no son otra cosa que indicarle determinadas
palabras y su forma de ‘cortarlas’ segun la regla ortografica.
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9.2 MANEJO DE LA IMAGEN

Dado que se trata de un sistema de impresion propuesto en este manual, -
necesariamente se debe pensar en las imagenes a usarse en este trabajo,
que seran preparadas segun las exigencias de la prensa offset.

En esta parte se presenta algunas consideraciones técnicas a tomar en
cuenta para este propésito, a fin de no cometer errores que son muy
usuales cuando no se conoce profesionalmente este medio.

9.2.1 MODOS DE COLOR

Como se citd en capitulos anteriores el sistema de impresion offset y como
se trata de una impresion a todo color “full color” las imagenes tendran
que estar en MODO DE COLOR CMYK (cian, magenta, yellow, black) que es
el modo de cuatricomia para este caso.

9.2.2 RESOLUCION

Toda imagen se transmite al sustrato en forma de puntos. Por esta razén
se tomara en cuenta dos tipos de sustratos o material sobre el que se
imprimira, esto es; materiales porosos o absorbentes y satinados o lisos.

Por ejemplo, el papel periédico o bond, es un material absorbente y la
resolucion con que deben estar las imagenes es de 200 dpi (ppp) ‘puntos
por pulgada’.

Para imprimir en un papel cuché (satinado), la resolucion excelente vy
recomendada por los especialistas es de 300 dpi.

En nuestro medio lo garantizan las exigencias de uno de los diarios mas
importantes EL UNIVERSO. (segun su tarifario)

9.2.3 TAMANO

En esta parte pueden haber variaciones. Todo depende del destino que se
le dé a los artes. Si se trata de enviarlo a un periddico, es importante que
la imagen sea colocada en el arte al 100% y no se apliquen ampliaciones ni
reducciones fuera del procesador de imagen.

Cuando se trata de preparar una revista, folleto, broshure, etc, se puede
aproximar los tamanos, sin que esto signifique que esté incorrecto. Pero
debemos considerar el siguiente criterio.
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No se debe escalar la imagen, por sobre el +/- 50%, ya que no pudiera
dar buenos resultados al imprimirse o en el caso de tener una imagen
demasiado grande, haria lenta su manipulacién, cosa que iria en perjuicio
de la relacién prespuesto/tiempo.

9.2.4 TIPO DE ARCHIVO (FORMATO)

En la actualidad el formato de archivo usado en prensa es PSD, (PhotoShop
Document) que es el que habitualmente se usa en Adobe Photoshop para
guardar un documento el cual tiene las capas sin acoplar o cuando se ha
guardado una seleccion, ya que este formato permite retomar el trabajo
tal y como lo dejo.

Es un formato que no tiene perdidas, ya que no realiza compresion
alguna.

Aunque todavia algunos medios manejan el tradicional formato EPS
(PostScript encapsulado).

Se recomienda preferentemente el primero (PSD), fundamentalmente
por que el EPS se configura de manera diferente para cada plataforma
(Windows - Mac) y eso trae consigo un retraso cuando no se sabe muchas
veces su destino. El psd, no necesita ningln ajuste extra y abre en ambas
plataformas o sistemas operativos.

9.2.5 RECOMENDACION ADICIONAL

Cuando se use textos sobre las imagenes, es importante no olvidar
rasterizar esas capas o acoplarlas totalmente, lo mismo si se usan efectos
de capas.

Otra anotacidn final en este capitulo, es que cuando se trate de imagenes
vectoriales, se considere los puntos 9.2.1 y 9.2.3 y en cuanto al punto
9.2.4 se usara (ai) o (eps).

¥
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10.1 REVISION FINAL

Antes de enviar la revista empaquetada a la imprenta, se debe considerar
que el proceso de impresion de peliculas o ‘preprensa’, se lo hara en otro
equipo o computador. Entonces se debe tomar en cuenta los siguientes
aspectos, dependiendo del software que se esté usando, en este caso es
“Adobe InDesign”.

10.1.1 SOBRE EL ARCHIVO NATIVO

Este archivo es el que se genero en el software de diagramacion (.indd) que
corresponde al editable de InDesign. Se debe asegurar que corresponde a
la version de la aplicacion en que se hara la preprensa.

10.1.2 SOBRE EL TEXTO (TIPOGRAFIA)

Se debera incluir una carpeta con el nombre FONTS o FUENTES vy alli se
colocaran todas las fuentes que se hayan utilizado en esta revista. Se sabra
que para el caso de InDesign, no sera necesario, ya que estas acciones se
hacen automaticamente al empaquetar.

Si es el caso, se pueden convertir a curva, aquellas palabras cortas que no
se desee incluir las fuentes por cualquier razén.

10.1.3 SOBRE LOS ARCHIVOS DE IMAGEN

Al igual que se cred una carpeta de FONTS, se debe crear otra carpeta con
el nombre IMAGES o IMAGENES vy colocar alli Gtnicamente las imagenes que
son parte de la revista. Obviamente, estas imagenes debieron cumplir con
las condiciones técnicas ya antes citadas.

10.1.4 EMPAQUE FINAL

Una vez que estén listas las dos carpetas y el archivo nativo, crear una
carpeta final con el nombre de la revista (ej.) RITMOS/ABRIL y alli poner
la carpeta FONTS, la carpeta IMAGES vy el archivo (.indd) o el que haya
generado el software de diagramacion que se uso.

Ahora si, el empaque esta listo para ser enviado a la imprenta.
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10.2 IMPRESION FINAL

A la imprenta puede llegar el archivo original sin ser compaginado, porque
dependera de ellos la forma final de maquetacion para llevarlo a la pelicula.
Esto dependera del formato de la prensa (offset).

Pero aqui dos ejemplos muy comunes.

10.2.1 COMPAGINACION SIMPLE A DOS PAGINAS

Es la compaginacion de multiplos de 4 y que deberan coincidir segun el
machote. Ejemplo:

Suponga que se trata de una revista de 40 paginas sin contar portadas.
Entonces la revista estara dividida en los tiros y retiros siguientes:

IZQUIERDA DERECHA ORDEN
40 1 TIRO 1
2 39 RETIRO 1
38 3 TIRO 2
4 37 RETIRO 2
36 5 TIRO 3
6 35 RETIRO 3
34 7 TIRO 4
8 33 RETIRO 4
32 9 TIRO 5
10 31 RETIRO 5
30 11 TIRO 6
12 P, RETIRO 6
28 13 TIRO 7
14 27 RETIRO 7
26 15 TIRO 8
16 25 RETIRO 8
24 17 TIRO 9
18 23 RETIRO 9
22 19 TIRO 10
20 21 RETIRO 10
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10.2.2 COMPAGINACION POR CUADERNILLOS

Este tipo de compaginacién por cuadernillos es muy usada para revistas
y libros grandes. Se tomara como ejemplo la revista RITMO realizada con
esta técnica.

El nimero de paginas de la revista, debe ser preferentemente multiplo de
8 para poder armar cuadernillos de 4 pares (8 paginas encontradas).

Quedaran entonces armados los cuadernillos de 8 paginas de tiro y 8 de
retiro. Para el ejemplo citado, quedaran 2 tiros con sus respectivos retiros.
(Figuras 10.1 al 10.4)

Estos quedaran plenamente registrados en secuencia y el doblez sera de la
siguiente manera, tomando en cuenta que la cara externa sera el tiro.

Existen varias formas de elaborar los cuadernillos, pero la ventaja es que
no importa cuantas paginas sean porque los cuadernillos van en secuencia.
Esto ayuda mucho, puesto que se pueden seguir aumentando las paginas y
lo demas se puede estar pasando a pre-prensa.

Una vez terminada la elaboracion de cuadernillos, se procede a laimpresion
de peliculas y posteriormente a la impresion de las planchas metalicas para
offset (fotomecanica).

EDCOM Capitulo 10 - Pagina 3 ESPOL
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TIRO 1

girmo

. e 3=t
Figura 10.1: Cuadernillo de Tiro 1 v )

RETIRO 1

Figura 10.2: Cuadernillo de Retiro 1
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TIRO 2

Figura 10.3: Cuadernillo de Tiro 2

RETIRO 2

3 nsjEs uj
“ap spaagnhsx

SUDEDT Y ITEAN

Figura 10.4: Cuadernillo de Retiro 2
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En la actualidad, en el mercado de la prensa, ya existen las denominadas
planchas CTP (Computer to plate - del computador a la plancha). (F 10.5).

Figura 10.5: Impresora de planchas CTP

Estas planchas permiten aprovechar la precision y la eficiencia del filmado
CTPdigital ylaimpresion sinaguay utilizan sistema de filmado laser térmico,
un proceso sin pelicula, libre de elementos quimicos en un entorno de luz
ambiente que produce imagenes nitidas y extremadamente bien definidas,
para unas prestaciones superiores durante la impresion.

Las planchas y el filmado CTP eliminan procesos y variables de produccion,
ahorrando tiempo, reduciendo los costos de material y trabajo y haciendo
mas eficiente el flujo de trabajo.

No se requiere cuarto oscuro, procesado, engomado ni horneado. Una vez
filmadas, simplemente hay que limpiar las planchas y ya estan listas para
imprimir.

Las prensas sin agua imprimen de manera mas limpia y nitida, con menos
ganancia de punto y con mayor consistencia que los métodos convencionales
de offset humedo. Aumentan las prestaciones en la impresion sin agua
con las planchas rapidas y de facil produccion, cuya estructura Gnica vy
tecnologia de filmado se combinan para aportar alta resolucion, estabilidad
y un entintado excelente.
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10.2.3 A LA PRENSA

Una vez realizada la pre-prensa de los artes compaginados y pasado a la
plancha metalica, en cualguiera de los casos citados, se continua con la
prensa.

La técnica ya fue expuesta en capitulos anteriores. Solamente cabe indicar
el procedimiento final.

Una vez impreso, se hacen los doblez de los cuadernillos (para el caso de
las compaginaciones por cuadernillos). Se compagina, se grapa, se engoma
0 se cose y posteriormente se corta o refila (quitar excedentes).

De esta manera, el producto impreso esta listo.

Es recomendable el control permanente de cada parte del proceso de
produccién, a fin de hacer las correcciones oportunas en miras a evitar
perjuicios econdmicos, lo cual es uno de los factores que influyen mucho.

En las siguientes paginas, se presenta un amplio glosario de términos,
usados en este manual y otros no mencionados, pero de igual importancia
y que son de uso comun en este medio.
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GLOSARIO

Acabado mate

Acabado palido del papel o de la tinta (opaco).
Adherir hojas

El medio mediante el cual las hojas de un cuerpo de texto se sujetan unas
a otras a lo largo del corte de encuadernacion.

Alzado

En el proceso de encuadernacion, se denomina asi a reunir las hojas o
grupos de hojas.

APV (Acetato Polivinilico)

Adhesivo sintético de base acuosa que al secarse deja una pelicula
transparente de gran flexibilidad. Es de secado rapido y considerado
permanente. Perfecto adherente.

Arte o copia
Diseno final y texto listo para imprimir.
Bisagra

Parte flexible de la tapa sobre la cual se mueven la portada y contraportada.
Para formar una bisagra en una hoja o cuadernillo, se adhiere una tira de
papel o de tela a lo largo del corte de encuadernacion de la hoja (u hojas) de
forma tal que la tira sobrepase el corte de encuadernacion. Este conjunto
puede entonces ajustarse con bisagra al cuerpo de un texto mediante el
empastado de la parte de la tira de papel o de tela que sobresale de la
hoja (u hojas) y adhiriéndola al corte de encuadernacion de una hoja en el
cuerpo del texto. (Ver también bisagra interior y bisagra exterior)..

Bisagra exterior

Canal flexible de material de revestimiento que se localiza en el exterior
de un libro sobre el cual se abren la portada y contraportada . Espacio
entre las tapas del lomo y el hombro del lomo del cuerpo del texto al
cual se prensa el material de revestimiento. Conocido también como unién
Francesa o muesca francesa, union, bisagra, muesca, surco, canal y union
exterior.



Bisagra interior

El pliegue del canal que existe entre las dos mitades de una guarda donde el
cuerpo de texto se adhiere a su tapa (cobertura). También llamada bisagra
frontal y union interior.

Brillo

PN
El brillo o reflectancia del papel.

(.
Cabeza §

El corte (borde) superior de una hoja, carton o volumen encuadernado, que» B

rz‘ﬁ

N Ny

n‘,

se opone a la superficie sobre la cual se coloca el volumen en el estante en «g . °

posicion vertical
Cabezadas

Una pequena tira ornamental (por lo general algodén o seda mercerizados)
que se cose 0 pega en los extremos tanto de la cabeza como del pié del
lomo del cuerpo del libro en la mayoria de las encuadernaciones comerciales
del impresor. Las bandas de cabeza de hoy en dia, imitan las cabezadas
cosidas que se utilizaban para proteger la cabeza y el pié de las antiguas
encuadernaciones. Por lo general, ambas bandas se denominan cabezadas
pero la banda del pié también se conoce como carton pié.

Caja de un libro

Cubierta que por lo general consiste en dos cartones, material de
incrustado y material de cobertura. Las tapas y el lomo que, como una
unidad, encierran las paginas de un bloque de libro encuadernado. La caja
se realiza en forma separada del cuerpo de texto y mas tarde se la adhiere
al mismo mediante el proceso conocido como encajado.

Carton

Término general utilizado para hacer referencia al cartén fino, cartén gris,
cartéon paja, y demas utilizados como principal componente de las tapas
de un libro. Los mismos pueden estar compuestos de diferentes materiales
fibrosos laminados o de pulpa que se presionan hasta obtener hojas
grandes y planas que luego se cortan a la medida deseada y se cubren con
tela, piel, papel u otros materiales formando entonces las tapas del libro.
También se los denomina cartones tapa (revestimiento) o carton libro.

\"'

\ p‘r whS



Carton marfil laminado

Fino papel cartdon de superficie adecuada para la escritura y la impresion.
Se lo utiliza para alinear el lomo de una caja. Por ejemplo en las bibliotecas
el carton marfil se utiliza en las tarjetas indice.

Cartones

Parte rigida de detras y delante de un libro de tapa dura.

CMYK

Abreviatura Americana de azul, rojo, amarillo y negro. Los colores del
proceso de cuatricomia.

Conteo de paginas

Numero total de paginas de un libro incluyendo las que se encuentran en
blanco.

Contraste
Cambio tonal de color: del claro al oscuro.
Copia impresa

El producto de una impresora de ordenador, o texto impreso enviado para
mecanografiar.

Corte delantero

El corte de una hoja o un lomo opuesto a y paralelo a, su corte de
encuadernacion (es decir, opuesto a su borde central). El corte delantero
también se utiliza en un sentido mas amplio para hacer referencia a la
parte de un volumen opuesta a y, paralela a su lomo.

Cosido lateral
Encuadernacion mediante grapa a lo largo de un lado de la pagina.

Costura Smyth

Método de costura a maquina a través del pliegue para unir multiples
cuadernillos para forma un cuerpo de texto.



Cuadernillos

Grupo de dos o mas hojas normalmente dobladas por la mitad para crear
una unidad.

Cuatricomia

Proceso que combina los cuatro colores basicos para crear una imagen en
color impresa o, colores compuestos por los cuatro colores basicos.

Cuerpo del libro

Cuerpo principal de secciones o paginas, incluyendo las hojas de guarda
y los refuerzos del lomo, que se encuadernan juntas y luego se adhieren a
la caja (cubierta).

Desencuadernar / recortado

Liberar el cuerpo del texto de su cobertura tirando de los hojas de guarda
insertadas del cuerpo del texto y cortando la parte superior con una cuchilla
afilada o estilete.

Direccion del grano (o de la fibra)

Direccion en la cual se alinean la mayor parte de las fibras en un trozo de
papel o carton y direccion en la cual los hilos de urdimbre corren por la
tela. La direccion del grano en todos los materiales hechos por el hombre
utilizados en la encuadernacion deben ser paralelos al lomo del volumen.

Encajado/encartonado

Proceso mediante el cual se agrega adhesivo a las hojas finales exteriores
de un cuerpo de libro y se ajusta el mismo en su caja.

Encuadernacion

Departamento de acabado de una imprenta o empresa especializada en
conferir el acabado a los productos impresos (compaginar / alzar, plegar y
recortar). En una biblioteca es el departamento responsable de encuadernar
con tapas duras las publicaciones y reparar todo el material que tenga
danado el lomo.

Encuadernacion adhesiva

Encuadernaciénen la cual las hojas individuales se aseguran juntas mediante
un adhesivo aplicado en el lomo del bloque de texto. En los sistemas
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tradicionales se utilizan principalmente la goma de origen animal o los
adhesivos de acetato de polivinilo. En el moderno método Fastbind, se utiliza
un adhesivo plastico termofundible. Este tipo de encuadernacion también
se conoce como encuadernaciéon perfect. Las secciones con perforaciones
a lo largo del pliegue (para permitir la penetracion del adhesivo en los
pliegues y unir cada seccion) es una forma distinta de encuadernacion con
adhesivo. Conocida como encuadernacion perfo-burst o perfopunch . (Ver
también Encuadernacion Adhesiva de Doble Abanico).

Encuadernacion adhesiva de abanico doble

Encuadernacion adhesiva donde el margen posterior de cada hoja del
cuerpo de texto sin engomar se expone alrededor de 1,5 mm para la
aplicacion del adhesivo. El margen se expone a ambos lados de cada hoja
mediante la sujecion por abrazadera del cuerpo de texto sobre una especie
de prensa. Luego se desplazan las hojas en una direccion, y después en la
opuesta, aplicando adhesivo en ambos bordes. Esta encuadernacion aplica
el adhesivo en el borde interior de cada lado de cada hoja, no solamente
en el lomo y el margen interior de un lado de las hojas.

Encuadernacion a la caja

Método de encuadernacion en el cual la cubierta del libro (caja) se hace
en forma separada del cuerpo de texto y luego se adjunta al mismo. La
encuadernacion se realiza utilizando un adhesivo para unir los diferentes
cuadernillos (bloques de texto) a una caja (constituida por un cartén de
encuadernado cubierto con tela, plastico o piel). También se la conoce
como encuadernacion Perfect, encuadernacion de tela, encuadernacion de
edicion, encuadernacion dura y tapa dura.

Encuadernacion con alambre

Método de encuadernar libros con alambre a lo largo del corte de
encuadernado, con frecuencia utilizando lazada doble (anillo). Antes de que
apareciera el nuevo método con alambre, éste consumia bastante tiempo
ya que requeria varios pasos manuales para lograr perforar un libro con
sumo cuidado.

Encuadernacion de publicaciones

Asi se denomina al encuadernado entre tapas duras de varios ejemplares
de una revista o publicacion de forma tal que se asemeje a un libro. Los
ejemplares antiguos que se han enviado al taller de encuadernaciéon, que
han sido cubiertos con una encuadernacion y que se han ubicado en las
pilas. Varios ejemplares de una revista o periédico ordenados juntos bajo
una misma tapa.



Encuadernacion en espiral

Libro encuadernado con alambre en forma de espiral que se inserta a traves
de los agujeros perforados a lo largo del corte de encuadernacion.

Encuadernacion Perfect

También conocida como encuadernacion en tapa suelta. Término general
para describir un método de encuadernacion en el que las tapas del libro
se hacen separadamente del cuerpo del libro, uniendo posteriormente
ambos al pegar las hojas de guarda a los cartones. Encuadernacion de muy
buena calidad por lo general muy costosa pero que, gracias a Fastbind es
accesible a todos los bolsillos.

Encuadernar
Unir hojas mediante cable, hilo, adhesivo u otros medios.
Estampado

Imprimir una imagen sobre el papel de forma tal que se cree una forma en
relieve.

Estampado a hoja

Utilizar una matriz para colocar una imagen metalica o pigmentada sobre
el papel.

Exceso de tirada o Perdido

Exceso de copias impresas con respecto a la cantidad establecida. (Los
términos comerciales de la impresion consideran una orden realizada
la que cubre un 10% mas o menos de la cantidad establecida). En la
encuadernacion Fastbind, no es necesario considerar estos parametros,
cuando de la moderna produccion de impresion bajo demanda se trata.

Fastbind

Método patentado, excepcionalmente rapido de encuadernacion mediante
el cual los libros se abren quedando perfectamente planos. Encuadernacion
duradera y fuerte.

Formato

El tamano, clase de pagina, margenes, requisitos de impresion, etc. de un
producto final.



Forro

Se denomina de esta forma, a la mitad de la hoja de guarda que pegada
a la parte interna de las pastas y del libro sirve para mantenerlos unidos.
También se la conoce como: papel de pasta, guardas finales, guardas de
la contratapas.

Fresado

Los lomos de los libros pueden cortarse en una fresadora a los efectos
de prepararlos para la encuadernacion adhesiva de abanico doble o sobre
cosido. La maquina abraza el cuerpo de texto con el lomo hacia abajoy lo
mueve sobre una serie de cuchillas rotativas que cortar aproximadamente
entre 0,8 mm y 1,5 mm del margen de encuadernacion. De esta forma
eliminan el adhesivo antiguo, las hilachas, las grapas y / o los pliegues de
los cuadernillos. Luego de realizado el fresado, el cuerpo de texto consiste
solamente de tapas sueltas.

Fuente

Variedad de letras, nimeros, signos de puntuacién, etc de un diseno
dado.

Grabado a hoja
Estampar y grabar una imagen sobre el papel con una matriz.
Grapar por el lomo o A Caballete

Unir un cuadernillo mediante el grapado por el medio de las hojas
plegadas.

Guarda

La hoja (u hojas) que forman esa parte de la guarda plegada no adherida
a la parte interior del cartéon tapa. Su funcion es proteger la primera y
ultimas hojas del cuerpo del libro.

Hoja (Foil)

Pelicula pigmentada o metalica sobre hojas plasticas o rodillos utilizados
en la estampacion y la impresion a hoja.



Hombro

Corte exterior del lomo curvado (redondeado) del cuerpo de texto contra
el cual se ajusta la tapa de portada. El hombro se considera terminado
cuando ya se ha redondeado y se han sacado los gajos. También se lo
conoce como: surco, tope, reborde, surco, contrafuerte, y saliente.

Hueco

Parte o espacio de una encuadernacion en tapa suelta entre el lomo del
cuerpo del texto y el interior del lomo de |la portada.

Impresion ciega (Incolor)
Imagen incolora impresa sobre una pagina.
Impresion de color plano

En este método se especifican los colores de tinta especificos del Sistema
de tintas Pantone Matching por ejemplo. El negro es un color directo

Insertar

Adheriruna paginaaotraenunlibroen o cercadel margen de encuadernado
por medio e una tira adhesiva estrecha a lo largo del corte plegado.

Laminar
Cubrir con una pelicula, unir o encolar una superficie a otra.
Lomo

Es la parte del libro por donde se cosen o pegan los pliegos con la cubierta
o tapa. Es el corte de union de una libro o publicacién.En el lomo se suelen
imprimir el titulo del libro con varias indicaciones. En el término lomo
puede diferenciarse el término lomo de cubierta y lomo del cuerpo del
libro.

Lomo del cuerpo del libro

Los cortes traseros o plegadas de un grupo de secciones cosidas o, el corte
trasero pegado de un blogue de hojas de una encuadernacion adhesiva.
Ya sea plano o redondeado y con los cajos quitados, con frecuencia se lo
encola y refuerza con tela y papel (tarlatana y refuerzos de papel). Se lo
conoce también como: lomo o espalda.



Lomo portada

Espacio existente entre los cartones de una caja para acomodar el espesor
del cuerpo del texto. La parte interior de este espacio se arma con una tira
en forma de lomo (por lo general hecha de carton marfil laminado o cartéon
Bristol). Se deja una zona tipo bisagra a cada costado de la tira en forma de
lomo que permite el movimiento de las tapas por encima de los rebordes
del cuerpo de texto cuando el libro se abre y se utiliza. La parte exterior
del lomo cobertor que usualmente lleva estampado el autor, el titulo y la
editorial. También se lo denomina, lomo, columna, etc.

Lomo plano

Antes de que el cuerpo del libro haya sido puesto entre tapas, el mismo
puede tratarse mediante la encuadernacion de lomo plano cuando su lomo
no ha sido aun redondeado ni enlomado. También se lo denomina Lomo
escuadra.

Mantilla

Asi se denomina la gruesa manta de goma existente sobre la prensa offset
y que transfiere tinta de la plancha al papel.

Maqueta

Diseno preliminar que muestra la posicion de las ilustraciones y del texto
segun vayan a aparecer en la reproduccion final o, la encuadernacion
realizada de los materiales finales para controlar el aspecto, tacto, peso,
etc, del libro.

Marcado

Hendido realizado en el papel para lograr un mejor plegado.

Marcas de corte

Lineas impresas que indican por donde se debe cortar una hoja impresa.
Margen de Pinza

El margen frontal del papel segun pasa a través de la prensa. El borde no

susceptible de ser impreso mide aproximadamente entre 1,2 mm a 10
mm.



Medianil (margenes)

El canal y el espacio marginal combinado, constituido por los dos margenes
interiores o posteriores de dos paginas enfrentadas de un volumen.

Misma cubierta
Utilizar el mismo papel de texto para la cubierta.
Muescas (Hacer las muescas)

Proceso mediante el cual en el lomo se realizan marcas perpendiculares al
corte de encuadernacion a fin de reforzar la encuadernacion adhesiva.

Opacidad

Propiedad del papel que minimiza la posibilidad de que un texto de una
pagina se vea a través de la siguiente.

Papel autocopiativo
Papel de escritura sensible a la presion que no utiliza papel de calco.
Papel carton

Término general utilizado para nombrar el papel que supera el indice (Index)
110# *, el cover 80# * o el de 200gr /m2 que por lo general se utiliza para
productos tales como carpetas de archivo, muestrarios y tarjetas. También
se lo denomina carton papel. Nota: el Index 110# es uno de los papeles
mas economicos y livianos que se utiliza para folleteria y, el cover 80# es
uno de los papeles mas pesados utilizados para las tapas lo que las vuelve
duraderas y fuertes.

Papel cubierta

Un papel impreso pesado utilizado para cubrir libros, realizar carpetas de
presentacion, etc.

Papel escritura
Es un papel liviano, generalmente utilizado para la escritura comercial,

la impresion y el fotocopiado. También se lo denomina papel comercial,
papel para comunicaciones o papel correspondencia.



Papel estucado

Tipo de papel recubierto con arcilla blanca o una sustancia similar que provee
una superficie suave para imprimir ilustraciones detalladas. El acabado es
con frecuencia brillante pero puede ser satinado o mate (apagado).

Papel estucado de alto brillo

Papel con un acabado muy brillante.

Papel High Bulk

Un papel mas grueso que el peso base estandar.
Papel Kraft

Papel fuerte de color marrén y hecho a maquina, ampliamente utilizado
para empaquetar y, en las encuadernaciones de las editoriales para alinear
el lomo rustico interior (tira de lomo) de un libro encuadernado con tapa
blanda.

Papel libro

El papel adecuado para libros, catdlogos, revistas, material publicitario y
de impresion general. Se clasifica en papel sin revestimiento (por lo general
el papel offset), el papel revestido o estucado (también llamado papel arte,
esmaltado, couche, lustre y brillante) y el papel texto.

Papel offset
Término utilizado para designar al papel sin cobertura o estucado alguno.
Papel tisu japonés

Papel absorbente de largas fibras, fuerte, bastante transparente, suave,
realizado con fibras de varias plantas oriundas de Japon , especialmente
la morera. Disponible en una gran variedad de colores y espesores.
Dependiendo del espesor, el mismo puede utilizarse para hojas de parche,
para el alineado total de las hojas como un refuerzo, para reparar jirones,
para reforzar los pliegues de secciones o para reparar las bisagras
interiores.

Percalina

En la encuadernacion Perfect tradicional se denomina percalina a una tela
especialmente preparada que se utiliza como material de recubrimiento



para tapas de libros. Tela tejida delgada, tintada, rellenada, impregnada
o cubierta con algun compuesto y luego sometida al calor y a la presidn.
Existen tres categorias principales: las que son rellenadas con almidon
(también llamada percalina a la medida), las impregnadas de vinilo, de
piroxilina, de acrilico y con cobertura de plastico. La percalina es bastante
liviana y se encuentra disponible en varios colores y calidades.

Peso base

En Estados Unidos de Norte América y en Canada, se denomina peso base
al peso, en libras, de una resma (500 paginas) de papel cortada a la medida
basica. También llamado peso resma y peso esencial. En los paises que
utilizan las medidas de papel de acuerdo a las normas ISO, es el peso, en
gramos, de un metro cuadrado de papel. También llamado gramaje y peso
resma.

Peso sustancial

Término que designa el peso base cuando se hace referencia al papel de
carta (de buena calidad).

Pie de un volumen

Parte inferior del lomo de un libro. Ver también “cabeza”.

Plegado francés

Dos pliegues en angulo recto uno con otro.

Pliegue

Doblez en cualquier material flexible, tal como papel, que se logra al doblar
una hoja sobre si misma - como cuando se dobla por la mitad. El pliegue a
lo largo de los lomos de las secciones a través de los cuales los mismos se

cosen, se grapan, se pegan o se unen uno con el otro mediante cualquier
otro método, se denomina pliegue de lomo.

PMS

Nombre abreviado del Pantone Color Matching System Sistema de Ajuste
del Color Pantone)

Prensa de alimentacion de hoja

Prensa que imprime pagina a pagina de un taco de hojas.



Proceso de impresion a color

Los colores primarios: amarillo, rojo, azul y negro se utilizan para lograr la
reproduccion total del color (CMYK).

Puntadas de cierre

Se denomina asi a las puntadas realizadas por maquinas de coser tipo
hogarenas y también las utilizadas en la encuadernacion de libros
tradicional, por ejemplo: en las bibliotecas, las maquinas utilizadas en la
encuadernacion, por lo general son mas grandes. Las puntadas se forman
con un primer hilo que se cose a lo largo de la superficie superior del
cuerpo de texto y un hilo de bobina que corre por la superficie inferior y
se cierra a intervalos regulares con el hilo superior.

Puntadas Kettle

En la encuadernacion de libros tradicional, son las puntadas mas cercanas
a la cabeza y al pié de cada cuadernillo de un cuerpo de texto que ha
sido cosido a mano a través del pliegue. Las puntadas kettle (en cadena)
cierran el hilo de coser luego de cada pase completo del hilo a lo largo del
lomo del cuerpo de texto y, unen cada cuadernillo al cuadernillo cosido
anteriormente.

Puntada lazada.

Método de encuadernacion tradicional. Por general los agujeros se perforan
a lo largo del corte de encuadernacion del cuerpo del libro. El hilo de
costura atraviesa el agujero de arriba abajo en forma sucesiva para juntar
las hojas. Las encuadernadoras de biblioteca cosen con puntada de lazada
las nuevas hojas de guarda a los cuerpos de texto sobrecosidos y cosidos
lateralmente cuando se los prepara para ser re entapados. redondear.

Redondear

Enla encuadernacion tradicional es el proceso mediante el cual se “martillea”
o moldea el lomo del cuerpo de libro en un arco de aproximadamente un
tercio del circulo preparandolo para el proceso de sacar cajos. El redondeo
disminuye el efecto de absorcion causado por el grosor de los hilos de costura
o la aplicacién del pegamento en la encuadernacion adhesiva. También
evita que el lomo del cuerpo del libro adquiera una forma céncava con el
paso del tiempo, el uso o por estar en posicion vertical en un estante.
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Reentapado

Proceso durante el cual se extraen al cuerpo del libro las tapas originales
y se le colocan unas nuevas siempre que el hilo de costura del cuerpo del
libro se encuentre intacto.

Registro

Ajuste de dos 0 mas imagenes en alineacion exacta entre si en la maqueta
de diseno o, el posicionamiento de las tapas en la encuadernacion perfecta
Fastbind.

Refuerzo

En el método tradicional de encuadernado, el refuerzo es el proceso
mediante el cual se forma una especie de protuberancia u hombrera a cada
lado del lomo del libro luego de haberlo redondeado y antes de reforzarlo.
El refuerzo acomoda el espesor de los cartones y ofrece una especie de
bisagra a lo largo de la cual éstos se mueven. El refuerzo también ayuda a
evitar que el lomo del libro no se deteriore tomando una forma céncava con
el paso del tiempo. (Ver también Redondear). Este proceso es innecesario
en la encuadernacién Perfect Fastbind.

Refuerzos

En el método tradicional, las capas de tela y papel utilizadas para reforzar
y armar el lomo del cuerpo de texto. Con frecuencia una o dos capas de
material se pegan al lomo del cuerpo de texto luego de haberlo redondeado
y enlomado. Por lo general, el primer refuerzo del lomo es tela rustica o
“tarlatana” y el segundo es una tira de papel liviano (refuerzo de papel).
En algunas encuadernaciones de editoriales comerciales muy grandes,
no puede utilizarse la "tarlatana” (o debe ser una calidad inferior), y se
encola solo un refuerzo de papel. En muchas encuadernaciones adhesivas
de algunas editoriales, no puede utilizarse el refuerzo. Los cuerpos de
texto no se refuerzan y simplemente se mantienen unidos mediante una
capa de pegamento. La idea principal es que los refuerzos del lomo del
cuerpo de texto deben reforzar el pegamento y ayudar a mantener juntas
las secciones.

Resma

500 hojas de papel.



Sangrado

Cantidad extra de imagen impresa que se extiende mas alla del borde
recortable de la hoja de papel, para permitir la impresion hasta el borde
de la hoja cortada.

Sobrecostura

En la encuadernacion tradicional, se denomina sobrecostura al proceso
por el cual el hilo de coser pasa a través de los cortes de cada “seccion”
en orden consecutivo, utilizando las perforaciones pre-hechas por las que
pasan las agujas ya sea a mano o a maquina a través de un margen de
encuadernacion de 1,5 mm o mas, para crear un cuerpo de texto.
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Tarlatana ‘

En la encuadernacion tradicional, malla gruesa y almidonada, de trama
abierta,(por lo general muselina, etc) que se utiliza para reforzar o armar
el lomo del cuerpo del libro para encuadernar a tapa suelta. La tarlatana
constituye el primer refuerzo del lomo del cuerpo del libro. El exceso
(tarlatana bisagra) que se extiende (generalmente una pulgada, 25 mm)
por encima de los bordes del lomo del cuerpo del libro se utiliza para
adherir este Gltimo a su caja. También se lo denomina muselina, lienzo
vasto y gasa.

Transparentar

Imprimir sobre una lado de la hoja de tal forma que pueda verse por el
reverso.

Troquelado

Proceso que utiliza afiladas regletas de acero para cortar formas especiales
de etiquetas, cajas y contenedores.

Volumen

Espesor de una hoja de papel en relacion a su peso basico

Vueltas

Parte de la tela de cubierta que esta doblada desde el exterior hacia el

interior sobre los bordes exteriores del carton (y tela del lomo). También
se denomina al proceso: mon



